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 এই অধ্যায়ের বিগত িছরসমূয়ের বিার্ড প্রয়ের বিয়েষণ: 

বিার্ড ২০২৪ ২০২৩ ২০২০ ২০১৯ ২০১৮ ২০১৭ 
ঢাকা ৫ ৪ ৪ ৫ ৬ ৪ 

রাজশােী ৫ ৪ 

সকল বিার্ড 

ঢাকা বিায়র্ডর 
অনুরূপ 

সকল বিার্ড সকল বিার্ড 

চট্টগ্রাম ৬ ৫ 
কুবমল্লা ৬ ৬ 
যয়শার ৩ ৪ ৩ 
িবরশাল ৬ ৫ 

ঢাকা বিায়র্ডর 
অনুরূপ 

বসয়লট ৪ ৩ 
বিনাজপরু ৫ ৩ 
মেমনবসিংে ৪ ২ 

 

 

 
 

 

01. প্রেজেজটেশজের খসড়াজে বলা হয়- [ঢা.বিা’২৪] 

 (a) File  (b) Handouts 

 (c) Slide  (d) Slide layout 

02. স্লাইজে ছবব যকু্ত েরার েন্য-  [ঢা.বিা’২৪] 

 (i) Insert প্রেনু প্রেজে Picture আইেে বিে 

 (ii) Picture বসজলক্ট েজর Insert এ বিে 

 (iii) Apply To 

 বনয়চর বকানবট সবিক? 

 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 

03. ফজোশপ প্রোগ্রাজে েয় ধরজের েুল আজছ? [ঢা.বিা’২৪] 

 (a) ৬৮ (b) ৬৯ (c) ৭০ (d) ৭২ 

04. এজোবব ফজোশপ প্রোগ্রাজে বপজেজলর ঘজর ৩০০ োইপ 

েরজল প্ররেজুলশে েত বপজেল হজব?  [রা.বিা’২৪] 

 (a) ৯০,০০০ (b) ৯,০০০ (c) ৯০০ (d) ৬০০ 

05. এজোবব ফজোশপ প্রোগ্রাজে বতৃ্তোর বসজলেশে প্ররখা ততবর েরার 

েন্য বেজের প্রোে Tool বে বযবহার েরা হয়?  [রা.বিা’২৪] 

 (a) Ctrl Rectangular Marquee Tool 

 (b) Shift Elliptical Marquee Tool 

 (c) Ctrl Lasso Tool 

 (d) Shift Crop Tool  
06. প্রোেবে দ্বারা বড় ছববর কু্ষদ্র সংস্করণ বঝুায়? [চ.বিা’২৪] 

 (a) োবেকং (b) োম্বজেইল (c) পযাজলে (d) আইেে 

07. ইলাজেের এ Color Mode অংজশ েয়বে Option পাওয়া 

যায়?   [চ.বিা’২৪] 

 (a) ২ (b) ৩ (c) ৪ (d) ৫ 

08. এেবে স্লাইে প্রেজে পরবতকী স্লাইজে যাওয়ার সেয় েী 

বযবহার েরজত হয়?  [চ.বিা’২৪] 

 (a) ইজফক্ট (b) এবেজেশে (c) প্রোে (d) ওপাবসবে 

09. পাওয়ার পজয়জটের ফাইলজে েী বলা হয়? [কু.বিা’২৪] 

 (a) স্লাইে  (b) হ্যাটে আউেস 

 (c) প্রেজেজটেশে (d) স্লাইে প্রলআউে 
 

 
 

01. d 02. a 03. b 04. a 05. b 06. b 07. a 08. a 09. c 
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 বনয়চর উদ্দীপয়কর আয়লায়ক পরিতডী দুবট প্রয়ের উত্তর িাও: 

 আফবরে ১০ে প্রেবণর বশক্ষেকী। ববদ্যালজয়র বাবষকে পরুস্কার 

ববতরণী অনুষ্ঠাজে েধাে বশক্ষে েজহাদ্য় তাজে ববদ্যালজয়র 

সাংস্কবৃতে অনুষ্ঠাজের এেবে প্রেজেজটেশে ততবর েরজত 

বলজলে। আফবরে তার স্লাইজে অজেেগুজলা ছবব যকু্ত েজর 

বিন্ন বিন্ন েবিয়ায় স্লাইে েদ্শকে েরল। 

10. আফবরজের প্রশষ োেবে েরার সবিে পদ্ধবত প্রোেবে? 

   [ি.বিা’২৪] 

 (a) Animations → Background style → Entrance 

 (b) Animations → Background style → Add Effect 

 (c) Animations → Custom Animation → Add Effect 

 (d) Custom Animation → Animations → Add Effect 

11. আফবরে তার োেবে আেষকণীয় েরার েন্য- [ি.বিা’২৪] 

 (i) ছববগুজলা বসজলক্ট েরল 

 (ii) blinds, fly in, diamond ইতযাবদ্ পছন্দেত ইজফক্ট 

বযবহার েরল 

 (iii) ‘Apply to all’ অপশে বযবহার েরল 

 বনয়চর বকানবট সবিক? 

 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 

12. প্রপস্ট েরার েী-প্রবােক েোটে প্রোেবে?  [ঢা.বিা’২৩] 

 (a) Ctrl + X (b) Ctrl + V 

 (c) Ctrl + C (d) Ctrl + P 

13. প্রেজেজটেশজের এে এেবে অংশজে েী বলা হয়? 

  [ঢা.বিা, ি.বিা’২৩] 

 (a) তেয (b) স্লাইে  

 (c) এবেজেশে (d) হ্যাটে আউেস 

14. পাওয়ার পজয়টে সফেওয়যাজর েী প্রবাজেকর Ctrl প্রবাতাে প্রেজপ 

প্ররজখ M োপজল প্রোেবে ঘেজব? [ঢা.বিা’২৩] 

 (a) স্লাইেবে েদ্বশকত হজব (b) সেল স্লাইে প্রদ্খা যাজব  

 (c) েতুে স্লাইে যকু্ত হজব (d) স্লাইে েবেফাই েরা যাজব 

15. োবিবেবেয়ার োধযে েয়বে? [ঢা.বিা’২৩] 

 (a) ২ (b) ৩ (c) ৪ (d) ৫ 

16. প্রোে প্রবাতাে োপজল প্রেজেজটেশজের েেে স্লাইে উপস্থাবপত 

হয়?  [রা.বিা’২৩] 

 (a) F5 (b) Esc (c) Ctrl (d) Insert 

17. এোবধে স্লাইে বববশষ্ট এেবে পষৃ্ঠাজে েী বলা হয়? 

  [রা.বিা’২৩, সকল.বিা’১৭] 

 (a) স্লাইে প্রলআউে (b) স্লাইে প্রশা  

 (c) প্রপইে প্রলআউে (d) হ্যাটে আউেস 

18. স্লাইজে বযােগ্রাউটেযকু্ত েরার েন্য প্রোে প্রেনু বযবহৃত হয়? 

 (a) Insert (b) Design [রা.বিা’২৩] 

 (c) Animations (d) View 

19. োবিবেবেয়ার উপাদ্াে ‘বণক’ অপর েী োজে পবরবেত? 

 (a) বিবেও (b) প্রেেে  [রা.বিা’২৩] 

 (c) গ্রাবফে (d) এবেজেশে  

20. প্রোে সফেওয়যাজর ছবব, গ্রাফ, োেক সংজযােে েজর 

আেষকণীয় েরা যায়?  [চ.বিা’২৩] 

 (a) অবফস সফেওয়যার (b) পাওয়ার পজয়টে  

 (c) প্ররেেবশে প্রোগ্রাে (d) ওয়ােক েজসসর 

21. প্রেেে, গ্রাবফে, অবেও বদ্জয় েেজেটেস ততবরর 

সফেওয়যারবের োে বে?  [চ.বিা’২৩] 

 (a) এজোবব ইলাজেের (b) পাওয়ার পজয়টে 

 (c) বপোশা (d) এজোবব ফজোশপ 

22. বেোইজের োজে ববশ্ববযাপী প্রোগ্রােবের োে- [চ.বিা’২৩] 

 (a) এজেল প্রোগ্রাে (b) ইলাজেের প্রোগ্রাে  

 (c) পাওয়ার পজয়টে প্রোগ্রাে (d) োোজবে প্রোগ্রাে 

23. ইটোরঅযােবেি োবিবেবেয়া প্রোেবে? [চ.বিা’২৩] 

 (a) বশক্ষােলূে সফেওয়যার (b) প্রেবলবিশে 

 (c) প্ররবেও (d) বসজেো 

24. প্রোজো ফজোশপ বপজেজলর ঘজর ৭২ োইপ েরজল প্রসই 

ফাইজলর প্ররেজুলশে েত হজব? [চ.বিা’২৩] 

 (a) ৭২২৭  (b) ২৭২৭ 

 (c) ৭২৭২  (d) ২৪২৪  
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 বনয়চর উদ্দীপকবট পয়ে পরিতডী দুইবট প্রয়ের উত্তর িাও: 

 প্রেহা এজোবব ফজোশজপ এেবে ফাইল ওজপে েরজব। এেন্য 

প্রস ফাইল প্রেনু হজত New এ েোটে েরজলা। ফজল এেবে 

োয়ালগ বে ওজপে হজলা। 

25. োয়াগল বজের color mode ড্রপ-োউে প্রেনুজত োই 

প্রোেবে-  [কু.বিা’২৩] 

 (a) RGB (b) CYMK 

 (c) Brown scale (d) Lab color 

26. উবিবখত োয়ালগ বজের background content অংজশ 

েতবে অপশে রজয়জছ?  [কু.বিা’২৩] 

 (a) 5 (b) 4 (c) 3 (d) 2 

27. অযাবেজেশজের সাজে সম্পেক রজয়জছ- [কু.বিা’২৩] 

 (i) অবেও (ii) বিবেও  (iii) প্রেেে 

 বনয়চর বকানবট সবিক? 

 (a) i, ii (b) ii, iii (c) i, iii (d) i, ii, iii 

28. োবিবেবেয়ার বযবহার েরা হয় প্রোেবেজত? [কু.বিা’২৩] 

 (a) ববদ্যালজয়র ফলাফল েস্তুবতজত 

 (b) বাোজরর বহসাব েরজত  

 (c) বিজেে প্রখলার রাে বহসাব েরজত 

 (d) অযাবেজেশে েলবিত্র ততবরজত  

29. বেজের প্রোেবে োবিবেবেয়া? [য.বিা’২৩] 

 (a) প্রেবলবিশে (b) প্ররবেও 

 (c) সংবাদ্পত্র (d) পািযবই 

30. স্লাইে ট্রােবেশে েেুো প্রোে প্রেনুজত পাওয়া যায়? [য.বিা’২৩] 

 (a) Animations (b) Design  

 (c) Review (d) Picture  

31. োবিবেবেয়া েেজেটেস প্রেজিলপার বতবে, বযবে- [ি.বিা’২৩] 

 (i) বিবেও বেজয় োে েজরে  

 (ii) এবেজেশে বেজয় োে েজরে 

 (iii) গ্রাবফে বেজয় োে েজরে 

 বনয়চর বকানবট সবিক? 

 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 

32.  পাওয়ার পজয়জটে ফাইলজে েী বজল? [ি.বিা’২৩] 

 (a) ট্রােবেশে (b) এবেজেশে  

 (c) প্রেজেজটেশে (d) স্লাইে 

 বনয়চর উদ্দীপয়কর আয়লায়ক পরিতডী দুবট প্রয়ের উত্তর িাও: 

 তাবেে েবে প্রেবণর বশক্ষােকী। বশক্ষে েোব প্রোোঃ রবফে 

ববজ্ঞাে ববষজয়র এেবে অধযায় প্রেজে বেছু অংশ েজেক্টজরর 

োধযজে উপস্থাপে েরজলে। এজত তাবেেসহ সহপািীজদ্র 

ববজ্ঞাে ববষজয় প্রয িীবত বছল তা দূ্র হল। 

33.  বশক্ষে েোব প্রোোঃ রবফে িাস উপস্থাপোর েন্য প্রোে 

সফেওয়যার বযবহার েজরে?  [ি.বিা’২৩] 

 (a) MS-Word (b) MS-Excel  

 (c) MS PowerPoint  (d) Adobe Photoshop 

34. ইটোরঅযােবেি োবিবেবেয়া প্রোেবে? [বস.বিা’২৩] 

 (a) প্ররবেও (b) বিবেও প্রগেস  

 (c) বিবেও (d) প্রেবলবিশে 

35. ইটোরঅযােবেি োবিবেবেয়ার অন্তিুকক্ত- [বি.বিা’২৩] 

 (i) বসজেো  

 (ii) বিবেও প্রগেস (iii) বশক্ষােলূে সফেওয়যার 

 বনয়চর বকানবট সবিক? 

 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii  

36. বেজের প্রোেবেজত এবেজেশে বেয় এেবে ববষয়? [ম.বিা’২৩] 

 (a) ববজ্ঞাপে (b) েদু্রণ ও েোশো  

 (c) সংবাদ্পজত্র (d) বেবেয়া 

37. পাে বা প্ররখা প্রোো বেেে েরার পবরোপজে েী বজল?  

  [সকল বিা’২০]  

 (a) অযাংের (b) প্ররেবুলউশে  

 (c) প্রোে  (d) বপজেল 

38. ইলাজেেজর অক্ষজরর আউেলাইে ততবর েরার েোটে হজলা- 

 (i) shift + ctrl প্রেজপ O প্রবাতাজে োপ  [সকল বিা’১৯] 

 (ii) type প্রেনু প্রেজে create outline  

 (iii) shift + Alt প্রেজপ O প্রবাতাজে োপ  

 বনয়চর বকানবট সবিক? 

 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 

39. ইলাজেেজর োইপ েুজলর সাহাজযয েয়িাজব প্রলখা ববন্যাস 

েরা যায়?  [সকল বিা’১৯] 

 (a) ২ (b) ৩ (c) ৪ (d) ৫ 
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40. োইজরক্ট বসজলেশে েুজলর অপর োে েী? [সকল বিা’১৯] 

 (a) েীল তীর (b) সাদ্া তীর 
 (c) োজলা তীর (d) লাল তীর 
41. এজোবব ইলাজেেজরর েধাে োে প্রোেবে? [সকল বিা’১৯] 

 (a) অঙ্কে বশজের োে (b) ছবব সম্পাদ্োর োে 
 (c) আেন্ত্রণপত্র প্রলখা (d) ফলাফল ততবর েরা 
42. ইলাজেের গ্রুজপর আইেে হজলা- [য.ব ো.’১৯] 
 (i) ছবব  (ii) প্রশপ (iii) োেক 
 বনয়চর বকানবট সবিক? 
 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 
43.  ইলাজেের প্রোগ্রাজে এোবধে অবজেক্টজে এেবে অবজেজক্ট 

পবরণত েরজত প্রোে েোটে বদ্জত হজব?  [সকল বিা’১৮] 
 (a) File → Group (b) Object → Group 

 (c) Window → Group (d) Edit → Group 

44. েুে-ইে এর েীজবােক েোটে েী?  [সকল বিা’১৭] 
 (a) ctrl+– (b) ctrl+= (c) ctrl++ (d) ctrl+* 
 

 

 বনয়চর উদ্দীপয়কর আয়লায়ক পরিতডী দুবট প্রয়ের উত্তর িাও: 
 রবেব এেবে প্রোম্পাবের েধাে েেকেতকা। আগােীোল 

ববজদ্শ প্রেজে এেদ্ল পবরদ্শকে তার প্রোম্পাবে পবরদ্শকজে 
আসজব। বতবে তাাঁর লযাপেজপ বজস বিে েরজছে অবতবেজদ্র 

তাাঁর প্রোম্পাবে সম্পজেক েী েী প্রদ্খাজবে। এোজে বতবে 
এেবে সফেওয়যাজরর সাহাযয বেজলে। 

45. ববজদ্বশ অবতবেজদ্র সােজে উপস্থাপজের েন্য রবেব সাজহজবর 
েন্য প্রোে সফেওয়যারবে বযবহার সুববধােেে? 

 (a) োইজিাসফে ওয়ােক 
 (b) োইজিাসফে পাওয়ারপজয়টে 

 (c) োইজিাসফে এজেল 
 (d) োইজিাসফে অযােজসস 

46. রবেব সাজহব প্রয সফেওয়যার বযবহার েরজবে তাজত- 
 (i) অযাবেজেশে বযবহার েজর উপস্থাপেজে আেষকণীয় েরা যাজব 

 (ii) শব্দ ও বিবেও বযবহার েজর প্রোম্পাবের োযকিে 

প্রদ্খাজো যাজব 

 (iii) প্রোম্পাবের আয় বযজয়র বহসাব েরা যাজব 
 বনয়চর বকানবট সবিক? 

 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 

47. Bangladesh 71 হল- 

 (a) presentation software  
 (b) graphics software   
 (c) multimedia software  
 (d) communication software  

48. এড োবি ফড োশডের ব ফল্ট ররজডুলশন কত? 

 (a) 36  (b) 72 
 (c) 96  (d) 64 

49. রকন Opacity িযিহৃত হয়? 

 (a) softness of the object (b) hardness of the object 
 (c) thickness of color (d) border of the object 

50. Stroke এর ররঞ্জ কত? 

 (a) 0-6  (b) 1-10 
 (c) 1-20  (d) 1-16 

51. এড োবি ইলোডে ডর কত প্রকোডরর  োইে  ুল আডে? 

 (a) 6 (b) 7 (c) 8 (d) 9 

52.  রেব ডয়ন্   ুল বিডলক্ট কডর মোউি কযোনভোডি বনডয় এডল 

রকোন বিডে েবরণত হডি? 

 (a) ∗  (b) – 

 (c) #  (d) + 

53.  স্লোইড  ট্রোনবজশন যকু্ত করোর জন্য রকোন রমনুডত বিক করডত 

হডি? 

 (a) Insert  (b) Animations 

 (c) Picture  (d) Background 

54. রকোডনো েবির অপ্রডয়োজনীয় অংশ িোদ রদয়োর জন্য রকোন 

 ুলব  িযিহোর করো হয়? 

 (a) ক্রে  (b) রলয়োর 

 (c) Flatten  (d) Opacity 

55.  রলোড ো ততবর, নকশো প্রণয়ন করোর জন্য রকোন রপ্রোেোমব  

িযিহোর করো হয়? 

 (a) এড োবি ফড োশে (b) এড োবি ইলোডে র 

 (c) েোওয়োর েডয়ন্  (d) এডেল 

56. ি গোকোর, িতৃ্তোকোর িো রযডকোডনো প্রকোর িদ্ধ েোডের রভতর 

স্থোবেত রলখোডক িডল- 

 (a) এবরয়ো র ে  (b) র ে  িে 

 (c) েোে  ুল  (d) অন-এ-েোে 
 

 
 

40. b 41. a 42. d 43. b 44. b 45. b 46. a 47. c 48. b 49. c 50. d 51. a 52. d 53. b 54. a 

55. b 56. a 
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57. রপ্রডজডন্ শডনর মোঝোমোবঝ অিস্থোডন েোকো অিস্থোয় ঐ স্লোই  

রেডক েরিতগী প্রদশগন শুরু করোর জন্য রকোনব  িোেডত হডি? 

 (a) Ctrl + F5 (b) Alt + F5  

 (c) Ctrl + Alt + F5 (d) Shift + F5 

58.  ফড োশডে েবি ততবর হয়- 

 (a) রলয়োডরর িোহোডযয (b) েযোডল  এর িোহোডযয 

 (c) বেডেডলর িোহোডযয (d) ব্রোডশর িোহোডযয  

59.  New Slide কমোন্  রকোন রমনুর অন্ত গত? 

 (a) রহোম   (b) ইনিো গ 

 (c) ররফোডরন্স  (d) রেইজ রল-আউ  

60. আমোডদর প্রকোশনোর প্রধোন মোধযম রকোনব ? 

 (a) কো জ  (b) মোবল্টবমব য়ো 

 (c) ওডয়ি   (d) ব বজ োল 

61. একব  ইডমজ িো েবির ি গোকোর কু্ষদ্রতম একক রকোনব ?  

 (a) ররজবুলউশন (b) বেডেল 

 (c) CMYK  (d) Color  

62. েবি িম্পোদডনর েদগো িো কযোনভোডির এডককব  স্তরডক িলো 

হয়- 

 (a) রলয়োর  (b) রে  (c) উেকরণ  (d) বফল্ড  

63.  িহু বমব য়োডক িহুমোবিকতো ও রপ্রোেোবমং ক্ষমতোর জন্য কী 

িলো হয়? 

 (a) এবনডমশন (b) বমব য়ো 

  (c) েোবফে  (d) ইন্ োরঅযোবক্টভ 

64.  রকোনব  িলমোন েোবফে? 

 (a) বভব ও (b) অব ও (c) র ে  (d) রলজোর  

65. Photoshop এ রমনুিোডরর বনডি কী রডয়ডে? 

 (a) রুলোর   (b)  যোি 

  (c) অেশনিোর  (d)  োইড লিোর  

66. বফদোর ঘর এ 10  োইে করডল প্রোডন্তর নমনীয়তো হডি- 

 (a) 10          (b) 15 (c) 20 (d) 25 

67. বিডলকশন  ুল কয়ব ? 

 (a) 2          (b) 3 (c) 4 (d) 5 

68. নতুন যকু্ত হওয়ো স্লোইড - 

 (i) Click to add title রলখো েোকডি  

 (ii) Click to add text রলখো েোকডি   

 (iii) Click to ok রলখো েোকডি  

 নিবের ককোিনি সনিক? 

 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 

69. এড োবি ইলোডে ডর রেোডকর ররখো িরু িো রমো োর েবরমোণ 

বনণগয় করোর জন্য কত েডয়ন্  েযগন্ত িযিহোর করো হয়? 

 (a) 0 রেডক 100 (b) 0 রেডক 1000 

  (c) 1 রেডক 100  (d) 1 রেডক 1000 

70. ফড োশডে বেডেডলর ঘডর 120  োইে করডল ররজডুলশন কত 

বেেডলর হডি? 

 (a) 120 (b) 240 (c) 480 (d) 14400 

71. ফড োশডে রয রলয়োডর েবি িম্পোদনোর কোজ করো হয় তোডক 

কী িডল? 

 (a) কোডরন্  রলয়োর  (b) অযোবক্টভ রলয়োর 

  (c) এব   রলয়োর  (d)  োড গ  রলয়োর  

72. কবম্পউ োডর মোবল্টবমব য়োর িযোেোরব  বভন্ন- এর কোরণ হল- 

 (a) বভব ও বেবমং (b) মোবল্ট রপ্রডজডন্ শন 

 (c) ইন্ োরঅযোবক্টবভব  (d) ব বজ োল রপ্রডজডন্ শন 

73.  Adobe Illustrator-এ রকোন রমোড , অিডজডক্টর প্রদবশগত 

রূে মবুদ্রত হয়? 

 (a) Preview  (b) Pixel Preview 

 (c) Printview (d) Overprint Preview 

74. বনডির রকোনব  COLOR MODE? 

 (a) CYMK (b) CMYK (c) RGL (d) RBG 

75.  িযোনোর, বিলডিো গ ইতযোবদ ততবরর কোডজ রকোনব  অিশযই 

প্রডয়োজন? 

 (a) ররপ্র বশ   (b) ওয়ো গ 

 (c) ইলোডে র  (d) েোওয়োর েডয়ন্  

76. ফড োশডে রহলোডনো েবি ক্রে করোর রশষ ধোডে Enter রিোতোডম 

িোে বদডল েবিব  কীভোডি স্থোবেত হডি? 

 (a) 60° রকোডণ (b) 45° রকোডণ 

 (c) রিোজোভোডি (d) লম্বভোডি 
 

 
 

57. d 58. c 59. a 60. a 61. b 62. a 63. d 64. a 65. c 66. c 67. b 68. a 69. b 70. d 71. d 

72. c 73. d 74. b 75. c 76. c 
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77. েোওয়োর েডয়ন্  স্লোইড - 

 (i) বভব ও যকু্ত করো যোয় (ii) অব ও যকু্ত করো যোয় 

 (iii) রলয়োর যকু্ত করো যোয় 

 নিবের ককোিনি সনিক? 
 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 

78. রপ্রডজডন্ শন িফ ওয়যোর িলো হয়- 

 (a) েোওয়োর েডয়ন্ ডক (b) ররপ্র বশ ডক 

 (c) ওয়ো গ প্রডিিরডক (d) এডেলডক 

79. ট্রোনবজশন হডলো এক ধরডনর- 

 (a) বভব ও (b) স্লোই  (c) ইডফক্ট (d) িিগুডলো 

80.  ফড োশডে িডিগোচ্চ কয়ব  রলয়োর যকু্ত করো যোয়? 
 (a) 3  (b) 5  

 (c) 10  (d) রযডকোডনো িংখযক 

 নিবের তবযের আব োবক পর ততী দুনি প্রবের উত্তর দোও: 

 মোবহর বনক  মতৃ বেতোর একব  িোদোকোডলো েবি রডয়ডে। রি 

েবি োডক রবিডন Convert করডত িোয়।  

81. মোবহ রকোন িফ ওয়যোরব  িযিহোর করডি? 
 (a) PowerPoint (b) Photoshop 

 (c) Illustrator (d) Maya  

82. উক্ত িফ ওয়যোর বদডয়- 

 (i) এবনডমশন যকু্ত করো যোয় 

 (ii) হোডত আঁকো েবি কবম্পউ োডর বনডয় িম্পোদন করো যোয়  

 (iii) েবির দো  িো ত্রুব  মডুে রফলো যোয়  

 নিবের ককোিনি সনিক? 
 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 
 নিবের তবযের আব োবক পর ততী দুনি প্রবের উত্তর দোও: 

 রোহোত নিম রেবণর েোি। রি র ে িই রেডক এড োবি 

ইলোডে ডর কোজ করোর েদ্ধবত বশডখডে। রি জোনডত েোরডলো 

রয, বফল ও রেোক রিোয়োডির বনডির িোবরডত রিশ কডয়কব  

আইকন রডয়ডে।  

83. উক্ত আইকডনর িংখযো কয়ব ? 

 (a) 2 ব  (b) 3 ব  (c) 4 ব  (d) 5 ব  

84. প্রেম আইকনব  বিক করডল কী হডি? 

 (a) কোলোর েযোডল  িবক্রয় হয় 

 (b) রেব ডয়ন্  েযোডল  িবক্রয় হয় 

 (c) অিডজডক্টর রেোডকর রং িোবতল হয় 

  (d) অিডজডক্টর বফডলর রং িোবতল হয় 

85. ফড োশডের  ুল িডের এডকিোডর উেডরর অংডশ েোডক-  

 (i) 3 ব  বিডলকশন  ুল (iii) 1 ব  মভু  ুল 

 (iii) 2 ব  মভু  ুল 

 নিবের ককোিনি সনিক? 
 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 
86. ‘PowerPoint’ রপ্রোেোডম  োইডের কোডজ প্রডয়োজন-  

 (i)  ুলিোর   (ii) বরিন 

 (iii) ফন্ -এর আকোর আকৃবত বিডলক্ট করো 

 নিবের ককোিনি সনিক? 
 (a) i, ii (b) i, iii (c) ii, iii (d) i, ii, iii 
87. এড োবি ইলোডে ডর  োইড ল িোর েোডক- 

 (a) একিোডর উেডর (b) েদগোর উেডরর িোম েোডশ 

(c) একিোডর  োডন  (d) বিডনর  োন েোডশ 
88. ফড োশডের রকোনব ডক বশল্পীর েবি আকঁোর কযোনভোডির 

িডি তুলনো করো রযডত েোডর? 

 (a) অেশন িোর (b)  োইড ল িোর 

 (c) রুলোডরর বনডি েদগো (d) রহোমডেজ 

89.  ফড োশডের বফল  োয়োল  িডের কনড ন্ ি অংডশ ইউজ 

ঘডর রকোনব  বিডলডক্ট  েোডক? 

 (a) িযোকেোউন্  (b) রেব ডয়ন্  

 (c) কযোনভোি  (d) রফোরেোউন্  

90. বফল ও রেোক রিোয়োডির বনডির িোবরর আইকন হডে- 

 (a) রফোরেোউন্ , ইডরজোর (b) কোলোর, রেব ডয়ন্ , নোন  

 (c) তুবল, রং  (d) েবি, ইডরজোর 

91. ইলোডে ডর নতুন ফোইল ততবর করোর ের েদগোয় েোওয়ো যোডি- 

 (a) নতুন শনূ্য ফোইল (b) ররপ্র শী   

 (c) নতুন রফোল্ডোর (d) ওয়ো গ প্রডিির 
92. রকোন েোডের শুরু এিং রশষ িডল বকেু েোডক নো? 

 (a) িক্র েোে   (b) মকু্ত েোে 

 (c) িদ্ধ েোে  (d) ওডেন েোে 

93. অিডজক্ট গ্রুে করোর িবিক বনডদগশনো রকোনব ?  

 (a) Object → Ungroup (b) Object → group 

 (c) Filter → group (d) Edit → group 

94. ইলোডে র রকোন বিডলডক্ট  অিডজডক্টর বফল িো রেোডকর রঙ 

িোবতল করোর জন্য রকোন আইকনব ডত বিক করডত হডি? 

 (a) কোলোর  (b) রেব ডয়ন্  

 (c) রলয়োর নোন  (d) নোন 
 

 
 

77. a 78. a 79. c 80. d 81. b 82. c 83. b 84. a 85. a 86. d 87. b 88. c 89. d 90. b 91. a 

92. c 93. b 94. d 
 

 

উত্তরমালা 


